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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2009 Hewlett-Packard Development Company, L.P.

This product includes Xerces XML Java Parser software, which is Copyright © 1999 The Apache Software 
Foundation. All rights reserved. 

This product includes JDOM XML Java Parser software, which is Copyright © 2000-2003 Jason Hunter & 
Brett McLaughlin. All rights reserved.

This product includes JClass software, which is © Copyright 1997, KL GROUP INC. ALL RIGHTS 
RESERVED.

This product includes J2TablePrinter software, which is © Copyright 2001, Wildcrest Associates (http://
www.wildcrest.com).

This product includes Xalan XSLT Processor software, which is Copyright © 1999 The Apache Software 
Foundation. All rights reserved.

This product includes EXPAT XML C Processor software, which is Copyright © 1998, 1999, 2000 Thai Open 
Source Software Center Ltd and Clark Cooper Copyright © 2001, 2002 Expat maintainers.

This product includes Apache SOAP software, which is Copyright © 1999 The Apache Software Foundation. 
All rights reserved.

This product includes O’Reilley Servlet Package software, which is Copyright © 2001-2002 by Jason Hunter, 
jhunter_AT_servlets.com.All rights reserved. 

This product includes HTTPClient Package software, which is Copyright © 1991, 1999 Free Software 
Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA.

This product includes Perl software, which is Copyright 1989-2002, Larry Wall. All rights reserved.

This product includes Skin Look And Feel software, which is Copyright © 2000-2002 L2FProd.com. All rights 
reserved.

This product includes nanoXML software, which is Copyright © 2000 Marc De Scheemaecker, All Rights 
Reserved.

This product includes Sixlegs PNG software, which is Copyright © 1998, 1999, 2001 Chris Nokleberg.

This product includes cURL & libcURL software, which is Copyright © 1996 - 2006, Daniel Stenberg, 
<daniel@haxx.se>. All rights reserved.

This product includes Quartz - Enterprise Job Scheduler software, which is Copyright 2004-2005 
OpenSymphony.
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This product includes Free DCE software, which is © Copyright 1994 OPEN SOFTWARE FOUNDATION, 
INC., © Copyright 1994 HEWLETT-PACKARD COMPANY, © Copyright 1994 DIGITAL EQUIPMENT 
CORPORATION, Copyright © 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, 
MA 02111-1307 USA.

This product includes DCE Threads software, which is Copyright © 1995, 1996 Michael T. Peterson.

This product includes JBoss software, which is Copyright 2006 Red Hat, Inc. All rights reserved. 

This product includes org.apache.commons software developed by the Apache Software Foundation (http://
www.apache.org/).

Trademark Notices

Java™ is a U.S. trademark of Sun Microsystems, Inc. Java™ and all Java based trademarks and logos are 
trademarks or registered trademarks of Sun Microsystems, Inc. in the U.S. and other countries.

Oracle® is a registered trademark of Oracle Corporation and/or its affiliates. 

UNIX® is a registered trademark of The Open Group.

Windows® is U.S. registered trademarks of Microsoft Corporation. 
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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
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Support

You can visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.

HP Software Support Online provides customer self-solve capabilities. It provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valued support customer, you 
can benefit by using the HP Software Support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 
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1 Report Pack Overview
This chapter describes the HP Network Node Manager i-series Software (NNMi) Incident and 
Availability Report Pack for NNMi 8.1x, 9.00 and HP Performance Insight (PI) 5.41:

• Consolidating PI and NNMi Data

• Directories and Reports

• Options for Customizing Reports

• Related Documents

Consolidating PI and NNMi Data

The NNMi Incident and Availability Report Pack consolidates PI and NNMi data into reports.

Collecting and Processing Data with PI

PI collects data from many sources, performs in-depth trend analysis, maintains performance 
baselines, and provides users with convenient, web-based reporting.

PI includes features such as the following:

• Distributed architecture

• Easy-to-scale architecture (supports data collection from thousands of agents)

• CODA/PA agent support

• Multiple-company security model

• Data warehousing

• Near Real Time reporting

• Forecasting 

• Multiple aggregations (by day, week, and month; by location; and by customer)

• Thresholding and alerting

• Easy-to-spot bottlenecks and easy-to-assess capacity trends

• Accurate and timely documentation for management
11



Defining Incidents with NNMi Attributes

NNMi 8.1x and 9.00 define incidents using the following attributes:

• Category

• Customer

• Device

• Device Type

• Severity

• Vendor 

Generating Reports with the Report Pack

The NNMi Incident and Availability Report Pack collects and processes data, and makes the 
results available to you in the following ways:

• Uses SOAP calls to collect incident and downtime data from any configured NNMi 
stations.

• Uploads the collected data to the PI tables on the PI server. 

• Processes the collected data by running summarizations and aggregations, and displays 
the results in report templates.

You can use the reports to do the following:

• Check whether the availability of a particular device is improving or worsening.

• Check whether the availability of a particular customer is improving or worsening.

• View the distribution of incidents across alarm categories.

• View the trend line for each incident category.

• View the distribution of severity levels.

• View the trend line for each severity level.

• Determine which devices are responsible for most of the alarms in each incident category.
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Directories and Reports

When you install the NNMi Incident and Availability Report Pack, PI creates the 
NNMI_Report directory. 

This directory contains the following subdirectories: 

• Availability

• INCIDENT

The Availability subdirectory contains five reports:

• Detailed Availability Report on Node Level

• Detailed Availability Report on Station Level

• Availability: Forecast by Customer

• Availability: Forecast by Vendor

• Availability: SLA

The INCIDENT subdirectory contains the following subdirectories:

• Category

• Severity

• Consolidated

In addition, the INCIDENT subdirectory contains some general reports.

General Subdirectory: 10 Reports

The General subdirectory contains the following reports:

• Executive Summary by Customer

• Executive Summary by Vendor

• Forecast by Category

• Forecast by Severity

• Hot Spot Reports

• Hot Spots: Top 20 by Device

• Incident Summary by Customer

• Incident Summary by Device Type

• Incident Summary by NNMi Station

• Incident Summary by Vendor
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Category Subdirectory: 4 Reports

The Category subdirectory contains the following reports:

• NNMi Incident by Category and Device 

• NNMi Incident by Category and Device Type

• NNMi Incident by Category and Severity

• NNMi Incident by Category and Vendor

Severity Subdirectory: 4 Reports

The Severity subdirectory contains the following reports: 

• NNMi Incident by Severity and Category

• NNMi Incident by Severity and Device

• NNMi Incident by Severity and Device Type

• NNMi Incident by Severity and Vendor

Consolidated Subdirectory: 5 Reports

The Consolidated subdirectory contains the following reports:

• Executive Summary by Category 

• Executive Summary by Severity 

• Hot Spot Report

• NNMi Incident by Category 

• NNMi Incident by Severity
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Options for Customizing Reports

You can customize reports to do the following:

• Share reports with customers.

• Limit what you see in reports.

• Change how you view tables and graphs.

Sharing Reports with Customers

If you want to share reports with your customers, you have to configure PI to produce 
customer-specific reports. 

To share reports with customers, follow these steps:

1 Use Common Property Tables to import customer names and device locations.

2 Create a group account for all the users affiliated with each customer.

3 Create a group filter for each group account.

For more about group filters, see the HP Performance Insight Administration Guide. 

Limiting What is Displayed in Reports

You can limit what you see in reports by changing parameter values. Changing a parameter 
value applies a constraint to the reports, so they show only the data you want to see.

The NNMi Incident and Availability Report Pack supports the following parameters: 

• Category

• Category ID

• Customer

• Customer ID

• Device

• Device Type

• NNMi Station

• Severity

• Severity ID

• Vendor

Changing a Parameter Value in Report Viewer

To change a parameter value in Report Viewer, follow these steps:

1 In the menu bar, select Edit  Parameter Values.

2 In the Modify Parameter Values window, click the Current Value field.

3 Enter a new value.

4 Click OK.
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Changing a Parameter Value in Web Access Server

To change a parameter value in Web Access Server, follow these steps:

1 In the lower-right corner of the report, click the Edit icon.

2 In the Edit Parameters window, type the constraint in the appropriate field.

3 Click Submit.

Changing the View of Tables and Graphs

You can customize reports to display tables and graphs the way you prefer to view them. You 
can change the default view for any table or graph. To find out how to change the view of 
tables and graphs, see Appendix A, Changing How You View Tables and Graphs.

Related Documents

The demo package for the NNMi Incident and Availability Report Pack contains a sample of 
every report in the package. If you want to see what fully populated reports look like, install 
the demo package. 

For information about the latest enhancements to this package, and any known issues 
affecting how this package operates, see the NNMi Incident and Availability Report Pack 1.2 
Release Notes in the PI Report Packs, CD-ROM.

For more information related to the NNMi Incident and Availability Report Pack, see the 
following documents: 

• Common Property Tables User Guide

• Integrating HP Network Node Manager and HP Performance Insight User Guide

• PI Report Packs, CD-ROM Release Notes, September 2009

• HP Network Node Manager i-series Software Online Help

• HP Network Node Manager i-series Software Deployment and Migration Guide

You can download these documents from the following website:

http://h20230.www2.hp.com/selfsolve/manuals

Use the following keywords to find specific documents:

• Performance Insight

User guides for PI

• Performance Insight Report Packs

User guides for report packs and datapipes

• Network Node Manager

User guides for NNMi

Each user guide includes a publication date. If the manual is revised and reposted, the date 
changes. Revised manuals are posted on a regular basis. Make sure to download the latest 
web editions. 
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2 Installing the Report Pack
This chapter explains how to install the HP Network Node Manager i-series Software (NNMi) 
Incident and Availability Report Pack: 

• Installation Requirements

• Installing the Report Pack

• Viewing the Deployed Reports

• Uninstalling the Report Pack

Installation Requirements

You cannot use the NNMi Incident and Availability Report Pack unless your NNMi and 
HP Performance Insight (PI) servers are integrated, and the system clocks on both servers are 
synchronized. If your servers are not yet integrated, integrate them now. To find out how to 
enable integration on the NNMi server, as well as how to run the Integration Wizard on the PI 
server, see the Integrating HP Network Node Manager and HP Performance Insight User 
Guide.

Before installing the NNMi Incident and Availability Report Pack, make sure that:

• On the PI server, the following software is running:

— HP Performance Insight 5.41

— All available Service Packs for PI 5.41

— Common Property Tables 3.92

• On the NNMi server, you have set up access to an NNMi account that is assigned to the 
Web Service Client User Account, as described in Creating a Web Service Client User 
Account on page 18.
  17



Creating a Web Service Client User Account

Before you can access the NNMi web services, you need to set up a Web Service Client User 
Account on the NNMi server.

To create a Web Service Client User Account, follow these steps:

1 On the NNMi server, go to the User Account form.

2 From the workspaces navigation panel, select the Configuration workspace.

3 Select the User Roles and Accounts view.

4 Do one of the following:

• To create a new configuration, click the New icon.

• To edit an existing configuration, select a row and click the Open icon.

5 In the Account Mapping form, locate the Role attribute.

6 From the drop-down menu, select a role.

7 In the Account Mapping form, locate the Account attribute and click the Lookup icon. 

8 Do one of the following:

• To select an existing account, click the Quick Find icon and select an account from the 
list. 

• To edit the current account, click the Open icon and continue. 

• To create new account, click the New icon and continue. 

9 Provide the required information.

10 Click Save and Close to return to the Account Mapping form. 

11 In the Role form, do one of the following:

• To save your changes and return to the User Accounts and Roles view, click Save and 
Close. 

• To add another user account, click Save and New. 
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Installing the Report Pack

To install the NNMi Incident and Availability Report Pack, perform the following tasks: 

• Task 1: Extracting Packages from the Report Pack CD

• Task 2: Upgrading Common Property Tables

• Task 3: Installing the Report Pack

Extracting Packages from the Report Pack CD

To stop the OVPI Timer and extract report packs from the report pack CD, follow these steps:

1 Log on to the system. 

On UNIX systems, log on as root.

2 Stop the OVPI Timer and wait for processes to terminate.

• Windows

Select Control Panel→Administrative Tools→Services.

• UNIX

As root, run the following:

— HP-UX

sh /sbin/init.d/ovpi_timer stop

— Solaris

sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD in the CD-ROM drive. 

4 Do the following:

• Windows

— If auto run is disabled, run the setup.bat command. 

— If outrun is enabled, a Main Menu appears. 

• UNIX

— If the CD does not mount automatically, mount the CD manually. 

— Run the setup command.

5 Type 1 to select PI report packs in the choice field and press Enter. 

The install script displays a percentage complete bar. When extraction is complete, the 
install script starts the Package Manager. The Package Manager Welcome window opens.

In the report pack, the Packages directory contains the following subdirectories:

• NNMi_Incident.ap

• NNMi_Incident_Demo.ap (optional)

The demo package is available as an option. You can install the demo package 
either by itself or together with the report pack.
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Upgrading Common Property Tables

If you are running an older version of Common Property Tables, upgrade to Common Property 
Tables 3.92. When the installation completes, click Done to return to the management console.

Installing the Report Pack

To install the NNMi Incident and Availability Report Pack, follow these steps:

1 Start the Package Manager.

2 In the Package Manager Welcome window, click Next. 

The Package Location window opens.

3 Click Install. 

If necessary, approve the default installation directory or use the browse feature to select 
a different directory. 

4 Click Next. 

5 In the Report Deployment window, do the following

a Accept the default settings for Deploy Reports. 

b Accept the defaults for the application server name and port. 

6 Enter your user name and password for the PI Application Server. 

7 Click Next. 

The Package Selection window opens. 

8 Select the check box next to the following packages:

• Common Property Tables 3.92 (if not already installed)

• NNMi_Incident 1.2

• NNMi_Incident_Demo 1.1

The Package Manager displays the name of the package currently being installed:

• NNMi_INCIDENT

• NNMi_Incident_Demo.ap (optional)

9 Click Next. 

The Type Discovery window opens. 

10 To run Type Discovery immediately after package installation, unselect Type Discovery 
and click Next. 

The Selection Summary window opens.

11 Click Install. 

The Installation Progress window opens and the install process begins. When the install 
process is complete, an installation complete message appears. 

12 Click Done. 

If you are not running any version of Common Property Tables, do not upgrade Common 
Property Tables. Do not install any other packages while upgrading Common Property Tables 
to the newest version.
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13 Restart the OVPI Timer.

• Windows

Do the following:

a Select Control Panel→Administrative Tools→Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

• UNIX

As root, run the following:

— HP-UX

sh /sbin/init.d/ovpi_timer start

— Solaris

sh /etc/init.d/ovpi_timer start

Viewing the Deployed Reports

When you install the report pack, as described in Installing the Report Pack on page 20, you 
enable the Deploy Reports option. As a result, the reports in this package (as well as any 
forms that come with it) are deployed to the PI Application Server. 

After reports reside on the PI Application Server, you can view them in two different ways:

• PI client applications

• Web browser

If the client applications are installed on your system, you have access to Report Viewer, 
Report Builder, and the management console. If you do not have the clients, use a web browser 
to reach the Web Access Server.

For more information about the clients, see the HP Performance Insight Installation and 
Upgrade Guide for your database application and operating system. For details about the 
management console, including how to use the Object/Property Management view to launch 
reports related to selected object, see the HP Performance Insight Administration Guide.
Installing the Report Pack 21



Uninstalling the Report Pack 

To uninstall the NNMi Incident and Availability Report Pack, follow these steps:

1 Log on to the system. 

On UNIX systems, log on as trendadm.

2 Stop OVPI Timer and wait for processes to terminate:

• Windows

Select Control Panel→Administrative Tools→Services.

• UNIX

As trendadm, run the following:

— HP-UX

sh /sbin/init.d/ovpi_timer stop

— Solaris

sh /etc/init.d/ovpi_timer stop

3 Start the Package Manager.

4 In the Package Manager Welcome window, click Next. 

The Package Location window opens.

5 Click Uninstall.

6 Click Next. 

The Report Undeployment window opens.

7 Do one of the following:

• If NNMi Incident and Availability reports were deployed from this server, accept the 
defaults for Undeploy Reports, Application Server Name, and Port. 

• Otherwise, clear the check box and go to step 9.

8 Type your user name and password for the PI Application Server.

9 Click Next. 

The Package Selection window opens.

10 Select the check box next to the following packages:

• NNMi_Incident 1.2

• NNMi_Incident_Demo 1.1

11 Click OK.

12 Click Next. 

The Selection Summary window opens. 

13 Click Uninstall. 

The Progress window opens and the removal process begins. When the uninstall process is 
complete, a package removal complete message appears. 

14 Click Done to return to the management console.
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15 Restart the OVPI Timer:

• Windows

Do the following:

a Select Control Panel→Administrative Tools→Services.

b From the list of services, select OVPI Timer.

c From the Action menu, select Start.

• UNIX

As trendadm, run the following:

— HP-UX

sh /sbin/init.d/ovpi_timer start

— Solaris

sh /etc/init.d/ovpi_timer start
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3 Setting Up a Distributed System
This chapter explains how to set up a distributed system with the HP Network Node Manager 
i-series Software (NNMi) Incident and Availability Report Pack:

• Steps to Set Up a Distributed System

• Reporting in a Distributed System

• Synchronizing System Clocks

• Installing the Report Pack

• Configuring the Central Server

• Configuring a Satellite Server

Steps to Set Up a Distributed System

This section outlines the steps you need to follow to set up a distributed system:

• Decide whether or not you want local reporting.

• Verify that the system clocks in your environment are synchronized.

• Install the correct set of packages (NNMi Report Pack packages) on each server.

• Register your satellite servers.

• If you are not copying rate data to the central server, enable LIR on the central server.

• If you enable LIR, add LIR mapping with the time type set to rate.

• Verify that you have all the copy policies you need.

• Configure the central server (manual edits to trendtimer.sched and .pro files).

• Configure each satellite server (manual edits to trendtimer.sched and .pro files).
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Reporting in a Distributed System

If you want to set up a distributed system, you can implement local reporting or you can 
implement centralized reporting. If you want local reporting, you need to deploy reports when 
you install the report pack on each satellite server, and you need to allow summarizations to 
run on each satellite server. If you do not want local reporting, then you do not need to deploy 
reports when you install a report pack on a satellite server and you can disable the scripts 
that run summarizations on each satellite server.

Before Location Independent Reporting (LIR) was available, our recommendation to anyone 
setting up a distributed system was to deploy reports on satellite servers, keep rate data on 
satellite servers, copy hourly data to the central server, and disable summarizations above the 
hourly level on satellite servers. The advantage to this approach was that it kept a large 
volume of rate data off the network and it decreased the processing load on the central server. 
The disadvantage is that the central server could not display a Near Real Time (NRT) report. 
The only NRT report was a local NRT report, on a satellite server. LIR overcomes this 
disadvantage. If you enable LIR, you can open an NRT report on the central server and 
drill-down on table selections. The selections you make cause the central server to query a 
satellite server for locally aggregated data. Of course, if you would rather copy rate data to the 
central server, you can. If you do that, then enabling LIR is not necessary.

The NNMi Incident and Availability Report Pack and several other report packs in the 
February 2009 release have a new copy policy import file. When you install the NNMi 
Incident and Availability Report Pack, PI uses this file to generate copy policies. As a result, 
you do not need to use the Management Console to create copy policies yourself. Instead, your 
only task is to verify that the copy policies you need already exist.

Because you are likely to have multiple satellite servers, we designed the hourly process files 
to be satellite-server friendly. This means that most of the time, most of the defaults are 
correct. But some defaults will be incorrect, or less than optimal, and so to improve 
performance you should change them. These manual edits, as well as the other steps listed 
above, are spelled out in detail below.

Synchronizing System Clocks

Make sure that the system clock on each satellite server is synchronized with the system clock 
on the central server.

Installing the Report Pack

Install the correct set of packages (NNMi Incident and Availability Report Pack packages) on 
each server. For details, see Chapter 2, Installing the Report Pack.
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Configuring the Central Server

To configure the central server, perform the following tasks:

• Task 1: Registering the Satellite Server

• Task 2: Optional: Enabling LIR

• Task 3: Optional: Adding LIR Mappings

• Task 4: Verifying Copy Policies

• Task 5: Editing Process Files

Registering the Satellite Server

To register a satellite server by setting the database role, follow these steps:

1 Start the management console.

2 Log on with Administrator privileges.

3 In the navigation pane, click the Systems icon.

4 In the PI Databases folder, select the database system.

5 Click Database Properties.

6 In the Database Role list, select the Satellite Server role.

7 Enter any information necessary to configure the Satellite Server role.

Optional: Enabling LIR

You enable LIR only if you do not want to copy rate data to the central server.

To enable LIR, follow these steps:

1 Start the management console.

2 Log on with Administrator privileges.

3 In the navigation pane, click the Systems icon.

4 In the PI Databases folder, select the central server.

5 Click LIR Configuration.

6 Select the LIR Enabled check box.

To add a new database reference, you can use the Add Database Reference Wizard in the 
System and Network Administration application.

If you copy rate data to the central server, you do not need to enable LIR. If you enable LIR, 
you must add LIR mappings, as described in Optional: Adding LIR Mappings on page 28.
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Optional: Adding LIR Mappings

If you add LIR mappings, a copy policy is automatically generated for the hourly data and for 
each LIR mapping that you add. The data type you select (in step 10 below) when adding an 
LIR mapping determines the type of data copied (defined in the generated copy policy). The 
type of data copied is one summarization level greater than the data type selected in the LIR 
mapping. For example, if you select an hourly data type, you generate a daily data copy policy.

To add LIR mappings, follow these steps:

1 Start the management console.

2 Log on with Administrator privileges.

3 In the navigation pane, click the Systems icon.

4 In the PI Databases folder, select the central server.

5 Click LIR Configuration.

6 Click Add Mapping.

7 In the Select Satellite Server list, select a satellite server to which to add a mapping.

8 Select the Category data table option.

9 In the drop down list, select NNMI_Incident.

10 Select the Rate data type.

11 Click Add to List.

To add a new database reference, you can use the Add Database Reference Wizard in the 
System and Network Administration application.

12 Optional: If you want to add additional LIR mappings, do the following:

a Click Add to List.

b Repeat step 6 through step 11.

13 Click OK.

14 Click Apply.

If you enable LIR, as described in Optional: Enabling LIR on page 27, you must add LIR 
mappings.
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Verifying Copy Policies

The NNMi Incident and Availability Report Pack contains a copy policy import file. When you 
install the Report Pack, PI uses this file to generate copy policies automatically. As a result, 
you do not need to use the management console to create copy policies yourself. Instead, your 
only task is to verify that the copy policies you need already exist.

Verifying Automatically Generated Copy Policies

The NNMi Incident and Availability Report Pack generates copy policies automatically. After 
installation, you must verify that a copy policy has been generated for the appropriate tables. 

To verify the automatically generated copy policy, follow these steps:

1 Start the management console.

2 Log on with Administrator privileges.

3 In the navigation pane, click the Copy Policy icon to start the Copy Policy Manager.

4 Make sure that the copy type is set to Property and Data for each of the following tables:

• SH_NNMI_INCIDENT

• SH_NNMI_Avail

• RVNNMI_Avail

A copy policy is required for RVVNNMI_Avail only if the cust_id, make and node_type 
variables are unique on each satellite server. If these variables are not unique, and a copy 
policy exists for this table, delete the copy policy.

Generating a Copy Policy Manually

The NNMi Incident and Availability Report Pack generates copy policies automatically. After 
installation, you must verify that a copy type is generated for the appropriate tables. If a copy 
policy has not been generated for a table, you must generate it manually.

To generate a copy policy for a table manually, follow these steps:

1 Do one of the following:

• Click the New Copy Policy icon.

• In the Copy Policy Manager, select File → New Copy Policy. 

The Copy Policy Wizard opens.

2 Click Next. 

The Satellite Server and Copy Policy Selection Page opens.

3 Select a satellite server from the drop-down list. 

Data is copied from this satellite server to the central server.

4 Select Single Table and select the table from the drop-down list.

5 Click Next. 

The Copy Type Selection Page displays.

6 Select Property and Data.

7 Click Next. 
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The Summary page displays.

8 Verify the information in the summary window. 

If the information is not correct, you can modify it after clicking Back.

9 Click Finish.

10 For all missing tables., repeat step 4 through step 9.

Setting the Copy Type Manually

The NNMi Incident and Availability Report Pack generates copy policies automatically. After 
installation, you must verify that the copy type is set to Property and Data. If the copy type is 
not set to Property and Data, you must set it manually.

To set the Property and Data copy type, follow these steps:

1 Double-click the copy policy.

2 Select the Property and Data copy type.

3 Click OK.

Editing Process Files

In NNMi, the hourly process files are designed for multiple satellite servers. Most of the 
defaults are correct most of the time. However, some defaults are incorrect, or less than 
optimal. To improve performance, you should change these less-than-optimal defaults. 

Modifying the hourly_NNMI_INCIDENT.pro File

If the central server is non-collecting, modify the hourly_NNMI_INCIDENT.pro file.

To modify the hourly_NNMI_INCIDENT.pro file, follow these steps:

1 Open the hourly_NNMI_INCIDENT.pro file in the following directory:

{DPIPE_HOME}/scripts/hourly_NNMI_INCIDENT.pro

In this path, {DPIPE_HOME} is the directory in which PI is installed.

2 If the server is a non-collecting central server, comment out block0.

Modifying the hourly_NNMI_Avail.pro File

To modify the hourly_NNMI_Avail.pro file, follow these steps:

1 Open the hourly_NNMI_Avail.pro file in the following directory:

{DPIPE_HOME}/scripts/hourly_NNMI_Avail.pro 

In this path, {DPIPE_HOME} is the directory in which PI is installed.

2 In block1, comment out the following line:

{DPIPE_HOME}/bin/trend_sum -f {DPIPE_HOME}/scripts/hourly_NNMI_Avail.sum

3 Optional: In block1, comment out the following line:

{DPIPE_HOME}/bin/trend_sum -f {DPIPE_HOME}/scripts/
hourly_NNMI_Avail_allnnm.sum
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Configuring a Satellite Server

In NNMi, the hourly process files are designed for multiple satellite servers. Most of the 
defaults are correct most of the time. However, some defaults are incorrect, or less than 
optimal. To improve performance, you should change these less-than-optimal defaults. 

To configure a satellite server, follow these steps:

1 Modify the hourly_NNMI_INCIDENT.pro file:

a Open the file in the following directory:

{DPIPE_HOME}/scripts/hourly_NNMI_INCIDENT.pro

In this path, {DPIPE_HOME} is the directory in which PI is installed.

b Make the following changes:

— Comment out block1_init.

— Uncomment block2, including the begin and end lines.

2 Modify the hourly_NNMI_Avail.pro file:

a Open the file in the following directory:

{DPIPE_HOME}/scripts/hourly_NNMI_Avail.pro 

In this path, {DPIPE_HOME} is the directory in which PI is installed.

b Make the following changes:

— If you configured a copy policy for the RVNNMI_Avail table on the central server 
(as described in Modifying the hourly_NNMI_INCIDENT.pro File on page 30), 
comment out the following two lines in block1:

{DPIPE_HOME}/bin/trend_sum -f {DPIPE_HOME}/scripts/
hourly_NNMI_Avail_allnnm.sum

{DPIPE_HOME}/bin/ovpi_run_sql -sqlscript  
{DPIPE_HOME}/scripts/{DBVENDOR}/update_SH_NNMI_Avail.sql -logfile  
{DPIPE_HOME}/tmp/update_SH_NNMI_Avail.out

— In block2, uncomment the following three lines:

begin: block2 wait

{DPIPE_HOME}/bin/trendcopy -t SH_NNMI_Avail

end: block2

— If you configured a copy policy for the RVNNMi_Avail table on the central server 
(as described in Modifying the hourly_NNMI_INCIDENT.pro File on page 30), 
uncomment the following line in block2:

{DPIPE_HOME}/bin/trendcopy -t RVNNMI_Avail

3 Make sure that each satellite server is collecting data from a disjoint set of NNMi 
stations.

Complete this step only if you did not configure a copy policy for the 
RVNNMI_Avail table, as described in Modifying the 
hourly_NNMI_INCIDENT.pro File on page 30.
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4 Collecting Data from the NNMi Station
This chapter describes how to collect data from the HP Network Node Manager i-series 
Software (NNMi) station: 

• Adding and Modifying Properties

• Creating, Updating, or Removing Property Data in PI Forms

• Collecting PI Data

• Synchronizing Node and Category Information

• Troubleshooting NNMi Stations

To collect incident and availability data, you need a list of NNMi stations. 

Adding and Modifying Properties

Property information comes from the following sources:

• Forms bundled with the NNMi Incident and Availability Report Pack

• Common Property Tables batch-mode property import

• Common Property Tables (Device, Customer, Vendor)

• Category List Table

• NNMi List Table

• NNMi List Table “add new” and “update” forms 

• Category List Table “add new” and “update” forms 

• Automatic feed from the network

If you have customers associated with specific devices or specific interfaces, or if you have 
vendors associated with specific devices, use Common Property Tables to import this 
information.

You can produce a list of NNMi stations by using PI forms to add, update or remove property 
data. For details, see Creating, Updating, or Removing Property Data in PI Forms on page 34. 
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 Creating, Updating, or Removing Property Data in PI Forms

You can use Performance Insight (PI) forms to create, update, or remove property data:

• Adding or Updating an NNMi Station

• Removing an NNMi Station

• Adding or Updating Category Information

• Removing an Alarm Category

• Updating the Availability Threshold

Navigating PI Forms

You can navigate all of the PI forms in the same way:

• Launching a Form

To launch a form, click the Objects icon in the left pane of the management console window. 
The Object/Property Management view opens. Object Manager shows a list of objects. The 
type of object presented depends on which Object Manager View is open. The default view 
is the Device view, showing a list of devices. 

• Changing a View

To change the view, select View→ Change View and use the pop-up window to select a 
different view. After the type of object you are interested in updating is in view, select the 
particular object you want to update. 

• Closing a Form

When you select the object, Object Specific Tasks appears in the right pan. Double-click 
and open the form. Click Apply to save changes, OK to save changes and close the form, or 
Cancel to close the form without saving changes.
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Adding or Updating an NNMi Station 

To add a new NNMi station, or modify an existing NNMi station, you use the Add or Update 
NNMi List form, shown in Figure 1.

Figure 1 Add or Update NNMi List Form

Use this form to do the following:

• Add a new NNMi station.

• Modify the following details for an existing NNMi station:

— NNMi Station

— Station Version

— Polling Interval (in minutes)

— Polling Granularity (in minutes)

— HTTP time-out (in seconds)

— HTTP Port

— Protocol

— User Name (NNMi User)

— Password (NNMi User Password)

— PI Database Server (<Name> tag from Systems.xml file for this database block)
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Adding a New NNMi Station

To add a new NNMi station, follow these steps:

1 Launch the management console.

2 Click the Objects icon. 

The Add or Update NNMi List form appears under General Tasks, as shown in Figure 1 
on page 35. 

3 Select any row. 

4 In the NNMi Station field, enter the name of the NNMi station. 

5 Change other values, as required.

6 Do one of the following:

• Click Apply to save changes.

• Click OK to save changes and close the form.

• Click Cancel to close the form without saving changes.

Updating an Existing NNMi Station

To update an existing NNMi station, follow these steps:

1 Launch the management console.

2 Click the Objects icon. 

The Add or Update NNMi List form appears under General Tasks, as shown in Figure 1 
on page 35. 

3 Select the NNMi station you want to update, and then double-click the Add or Update NNMi 
List form.

4 Highlight the row that contains the data you want to change.

5 If required, change the Polling Granularity, and then change the following entry in the 
$DPIPE_HOME/trendtimer.sched file:

01:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
NNMI_INCIDENT.pro

For example, if the Polling Interval is 180 minutes, you would change the entry as follows: 

03:00- - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
NNMI_INCIDENT.pro

Polling Granularity is the result of duration units divided by Polling Interval. For a given 
Polling Interval, data collected from incidents can be aggregated over smaller units of 
duration (called Polling Granularity). For example, if the Polling Interval is 60 minutes, 
the Polling Granularity can have values such as 15, 30, and 60 minutes.

6 Do one of the following:

• Click Apply to save changes.

• Click OK to save changes and close the form.

• Click Cancel to close the form without saving changes.

Currently, SSL is not supported. As a result, you cannot change the protocol from HTTP to 
HTTPS.
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Removing an NNMi Station

You can use the Remove NNMi Station form to remove a single NNMi station, as shown in 
Figure 2.

Figure 2 NNMi Remove NNMi Station Form

To remove a single NNMi station, follow these steps:

1 Launch the management console.

2 Open the Object/Property Management view. 

Select View→Change View.

A pop-up window lists the existing NNMi stations

3 Select the NNMi view you want to remove. 

4 Select the NNMi station you want to remove. 

5 Under Object Specific Tasks, double-click the Remove NNMi Station form.

The form opens, showing NNMi stations configured for PI data collection. 

6 Highlight the row that contains the NNMi station that you want to remove, as shown in 
Figure 2 on page 37. 

7 Do one of the following:

• Click Apply to save changes.

• Click OK to save changes and close the form.

• Click Cancel to close the form without saving changes.

After you remove an NNMi station, the NNMi station stops collecting data. 
Existing data is still available.
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Adding or Updating Category Information

You can use the Add or Update Category Information form to add or update alarm categories 
for an NNMi station, as shown in Figure 3.

Figure 3 Add or Update Category Information

Adding an Alarm Category for a New NNMi Station

To add an alarm category for a new NNMi station, follow these steps: 

1 Launch the management console.

2 Click the Objects icon. 

The Add or Update Category Information form appears under General Tasks, as shown in 
Figure 3 on page 38. 

3 Select any row. 

4 Enter the new Category Id and Category Name.

5 Do one of the following:

• Click Apply to save changes.

• Click OK to save changes and close the form.

• Click Cancel to close the form without saving changes.
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Updating the Alarm Category for an Existing NNMi Station

To update the alarm category for an existing NNMi station, follow these steps:

1 Launch the management console.

2 Click Objects. 

The Add or Update Category Information form is listed under General Tasks. 

3 Double-click the form. 

4 Double-click the NNMi station you want to update.

The form opens, showing category information. 

5 Highlight the row that contains the data you want to change, as shown in Figure 3 on 
page 38. 

6 Make the changes.

7 Do one of the following:

• Click Apply to save changes.

• Click OK to save changes and close the form.

• Click Cancel to close the form without saving changes.

Removing an Alarm Category

You can use the Remove Alarm Category form to remove a category for an NNMi station, as 
shown in Figure 4.

Figure 4 Remove Alarm Category Form
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To remove a category for an NNMi station, follow these steps:

1 Launch the management console.

2 Open the Object/Property Management view. 

Select View→Change View.

A pop-up window lists the existing NNMi stations

3 Select the NNMi station you want to remove, as shown in Figure 4 on page 39. 

4 Under Object Specific Tasks, double-click the Remove Alarm Category form. 

The form opens, showing NNMi stations, Category Id, and Category Name.

5 Highlight the row you want to remove. 

6 Do one of the following:

• Click Apply to save changes.

• Click OK to save changes and close the form.

• Click Cancel to close the form without saving changes.

Updating the Availability Threshold

The availability threshold (percentage of availability) values are based on NNMi station, 
Node Name, Customer Id, Vendor, and Device type. The threshold is the line between normal 
and abnormal performance. When this line is crossed, an exception is recorded. Thresholds 
are set to default values that are easily changed to reflect individual needs. You can use the 
Update Availability Threshold form to change the threshold value, as shown in Figure 5.
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Figure 5 Update Availability Threshold Form

To change the availability threshold value, follow these steps:

1 Launch the management console (by using piadmin).

2 Click Objects. 

3 Under General Tasks, double-click the Update Availability Threshold form. 

The forms opens, listing the NNMi stations and an availability threshold for each station, 
as shown in Figure 5 on page 41. 

4 Highlight the row that contains the availability threshold you want to change.

5 Make the changes. 

6 Do one of the following:

• Click Apply to save changes.

• Click OK to save changes and close the form.

• Click Cancel to close the form without saving changes.
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Collecting PI Data

After the NNMi stations list is provisioned, the system is ready for collection. 

During the first collection, the data collection tool does the following automatically:

1 Gets the nodes from NNMi with Device Type, Vendor, and Category information. 

2 Gets data for the last two days from the NNMi station or as available in NNMi, whichever 
is faster. 

3 Puts the Device Type, Vendor, and Category information list into HP Performance Insight 
(PI).

Synchronizing Node and Category Information

To synchronize the node information from all NNMi stations, use the 
get_nnmi_aggincident.pl tool. 

To update the NNMi Incident and Availability Report Pack with current node information 
from NNMi, use the following script:

$DPIPE_HOME/bin/perl $DPIPE_HOME/scripts/get_nnmi_aggincident.pl -i

Troubleshooting NNMi Stations

To troubleshoot problems related to the datapipe for NNMi stations, check the following log 
files, in sequence:

1 On PI, check the collection details for all NNMi stations in the following log file:

$DPIPE_HOME/log/trend.log 

Check for entries with get_nnmi_aggincident.pl, the module that collects incident 
data from NNMi stations.

2 On NNMi, check the collection details and failures, if any, in the following 
datapipe-specific log file:

$DPIPE_HOME/log/NNM8i_Datapipe.log

By default, the PI server collects data hourly, with 15 minute granularity.

Category and severity information are synchronized automatically. You cannot synchronize 
this information manually. 
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5 Sample Reports
This chapter provides samples of the following HP Network Node Manager i-series Software 
(NNMi) Incident and Availability Report Pack reports:

• Sample 1: Detailed Availability Report on Station Level

• Sample 2: Detailed Availability Report on Node Level

• Sample 3: Availability Forecast by Customer

• Sample 4: Availability: SLA Report

• Sample 5: Executive Summary by Vendor

• Sample 6: Incident Summary by NNMi Station

• Sample 7: Forecast by Severity

• Sample 8: Hot Spots: Top 20 by Device

• Sample 9: NNMi Incidents by Category and Device

• Sample 10: NNMi Incidents by Severity and Device

• Sample 11: Executive Summary by Severity

Calculating Availability

The incidents coming from NNMi station are collected and stored in Performance Insight for 
further calculation and reporting. By default the polling interval is one hour, and the polling 
granularity is 15 minutes.

Note that only those managed nodes that had an NNMi incident are considered by 
Performance Insight for calculations. Only such nodes appear on the Availability reports. If a 
node did not have an incident, it will not appear on the Availability reports. The nodes that 
are not shown on the reports are interpreted by Performance Insight as 100 percent available 
over the specified time interval.

Availability Metrics

Following are the description and calculation of the metrics displayed on the PI reports:

• Mean Time between Failures (MTBF) - This term denotes the mean time in seconds 
for which the device was up and running before it went down again. 

• Mean Time to Repair (MTTR) - This term denotes the mean time to repair or bring up 
the device. This metric is also termed as downtime.

• Availability % - This term denotes the percentage of time the device was available or up 
and running during the specified time period. The Availability % metric is calculated as 
follows:
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Availability % = ((Total Time - Downtime) / Total Time) * 100 

• Downtime - This term denotes the time in seconds when the device was down. Downtime 
is the same as MTTR.

• Total Outage - This term denotes the number of times a device went down in the 
specified time duration.

Example

The sample row in the following partial snapshot of a report shows the following metrics for 
the selected NNMi station:

• Total number of outages = 1

• MTTR or Downtime metric value = 1524 seconds. 

• Since the polling interval is by default one hour or 86400 seconds, consider

 Total Time = 86400 seconds.

Therefore, the Availability % is calculated as:

• Availability % = ((Total Time - Downtime) / Total Time) * 100

= ((86400-1524)/86400) * 100

= 98.24 percent.
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Sample 1: Detailed Availability Report on Station Level

The Detailed Availability Report on Station Level provides daily, monthly, and yearly 
availability information for a selected customer and type of device, on a per-vendor basis, as 
shown in Figure 6. The report does not show availability across multiple NNMi stations. It 
aggregates data at the NNMi station level.

Figure 6 Detailed Availability Report on Station Level

You select the NNMi station, and then select a vendor, customer, and device type. 

The table below the selection fields provides statistics for the following:

• Availability 

• MTTR 

• Total downtime

• MTBF

• Outage count

You can use the report to check whether the availability for a particular device type managed 
by a particular NNMi station is improving or worsening 
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Sample 2: Detailed Availability Report on Node Level

The Detailed Availability Report on Node Level provides daily, monthly, and yearly 
availability information for a selected customer and type of device, on a per-vendor basis, as 
shown in Figure 7. The report does not show availability across multiple NNMi stations. It 
aggregates data at the NNMi node level.

Figure 7 Detailed Availability Report on Node Level

You select the NNMi node, and then select a vendor, customer, and device type. 

The table below the selection fields provides statistics for the following:

• Availability 

• MTTR 

• Total downtime

• MTBF

• Outage count

You can use the report to check whether the availability for a particular device type managed 
by a particular NNMi node is improving or worsening. 
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Sample 3: Availability Forecast by Customer

If multiple NNMi stations are in use, the Availability Forecast by Customer report aggregates 
data from all of them, and rolls the data up to the customer level, as shown in Figure 8. After 
you select a customer, you can either select all device types or a particular device type. 

Figure 8 Availability Forecast by Customer Report

The bar graph provides baseline, F30, F60, and F90 values for the following:

• MTBF

• MTTR

• Availability

• Downtime

You can use the report to check whether the customer you selected is expected to see improved 
availability metrics or degraded availability metrics.
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Sample 4: Availability: SLA Report

The Availability: SLA Report aggregates data for multiple NNMi stations, as shown in 
Figure 9. 

Figure 9 Availability: SLA Report
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The report answers four questions:

• On average, is a particular vendor operating above or below the threshold for availability?

• Is a particular device type from one vendor operating above or below the threshold?

• On average, are the devices owned by a customer operating above or below the threshold?

• Is a device type owned by a particular customer operating above or below the threshold?

The report looks at downtime details as well as availability details. 

You can compare the following:

• Actual availability to the SLA value (the threshold for availability)

• Actual downtime to the SLA value (the threshold for downtime)
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Sample 5: Executive Summary by Vendor

The Executive Summary by Vendor report aggregates alarm category and alarm severity data 
at the vendor level, on a station-by-station basis, as shown in Figure 10. 

Figure 10 Executive Summary by Vendor Report

You can use this report to determine the following:

• Distribution of alarms across alarm categories

• Whether the number of alarms per category is increasing or decreasing

• Distribution of severity levels

• Whether the number of alarms per severity level is increasing or decreasing
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Sample 6: Incident Summary by NNMi Station

The Incident Summary by NNMi Station report aggregates the total number of incidents on a 
station-by-station basis, as shown in Figure 11. 

Figure 11 Incident Summary by NNMi Station Report

You can use the report to determine the following:

• Total for each NNMi station

• Whether the total is increasing or decreasing
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Sample 7: Forecast by Severity

The Forecast by Severity report produces an alarm severity forecast, as shown in Figure 12. 
The report aggregates severity data across all devices on a station-by-station basis, calculates 
a baseline value for each severity level, and enables you to compare the baseline value to F30, 
F60, and F90. 

Figure 12 Forecast by Severity Report

You can use the report to determine the following:

• Which severity level was most prevalent over the baseline period

• How each severity level is expected to behave in the future
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Sample 8: Hot Spots: Top 20 by Device

The Hot Spots: Top 20 by Device report aggregates incidents for each device on a 
station-by-station basis, as shown in Figure 13. You can use the report to determine which 
devices are responsible for the most incidents. You select a station, and then select a severity 
level. The graph below the report produces a list of devices, ranked by the number of 
incidents, from highest to lowest. The graph enables you to see incident statistics for the 20 
devices responsible for the majority of incidents.

Figure 13 Hot Spots: Top 20 by Device Report
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Sample 9: NNMi Incidents by Category and Device

The NNMi Incidents by Category and Device report aggregates incident category statistics on 
a station-by-station basis, as shown in Figure 14. You can use the report to drill down from an 
incident category to a list of the devices responsible for the alarms in that category. The 
devices are ranked by the number of incidents in that alarm category, from highest to lowest. 
You can use the report to determine which devices are responsible for the majority of incidents 
in each alarm category.

Figure 14 Incidents by Category and Device Report
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Sample 10: NNMi Incidents by Severity and Device

The NNMi Incidents by Severity and Device report aggregates severity level statistics on a 
station-by-station basis, as shown in Figure 15. You can use the report to drill down from a 
severity level to a list of the devices responsible for the alarms in that level. The devices are 
ranked by number of incidents in that severity level, from highest to lowest. You can use the 
report to determine which devices are responsible for the majority of incidents in each 
severity level.

Figure 15 NNMi Incidents by Severity and Device Report
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Sample 11: Executive Summary by Severity

The Executive Summary by Severity report compiles data about the number of incidents per 
severity level, as shown in Figure 16. The results are available on a vendor-by-vendor basis 
and on a customer-by-customer basis. After selecting the NNMi station, select a vendor and a 
severity level. The graph to the right shows the trend line for the number of incidents for this 
particular device and this particular severity level. You can also select a customer and a 
severity level. The graph to the right shows the trend line for the number of incidents for this 
particular customer and this particular severity level. You can use the report to determine 
whether the incident count for a severity level is increasing or decreasing.

Figure 16 Executive Summary by Severity Report
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A Changing How You View Tables and Graphs
This appendix describes the how to change the view options for tables and graphs in 
HP Network Node Manager i-series Software (NNMi).

Changing View Options

You can view any table or graph in several ways. Although the default view is usually 
adequate, you can easily change to a different view.

Changing View Options in Report Viewer

If you are using Report Viewer, right-click the object to open a list of view options.

Changing View Options in Web Access Server 

To change the default view of a table or graph using the Web Access Server, follow these steps: 

1 In the links bar, click Preferences.

2 In the navigation frame, expand Reports.

3 Click Viewing.

4 Select the Allow Element Editing box.

5 Click Apply.

6 Click the Edit icon next to the table or graph. 
 57



View Options for Tables

NNMi provides a wide variety of options that enable you to modify the way you view tables.

Opening a List of Table View Options

To open a pop-up menu of table view options, do one of the following:

• Report Viewer

Right-click a table.

• Web Access Server

Select the Edit Table icon.

The table view options menu is shown in Figure 17.

Figure 17 Table View Options Menu
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Table View Options

You can change a wide variety of table view options, as described in Table 1.

Figure 18 show the Table Viewer window opened by the View in New Frame option.

Figure 18 Table Viewer Window 

Table 1 Table View Options

Option Function

Set Time Period Alters the relative time period (relative to now) or set an 
absolute time period.

Use Absolute Time Shortens the period of time covered by the table from (for 
example, from 42 days to 30 or 7 days). If you are interested in 
a specific period of time that starts in the past and stops before 
yesterday, select a Start Time and an End Time.

Change Constraint Values Loosens or tightens a constraint, thereby raising or lowering 
the number of elements that conform to the constraint. To 
loosen a constraint, set the value lower. To tighten a 
constraint, set the value higher.

Select Nodes/Interfaces Enables you to change the scope of the table by limiting the 
table to specific nodes, specific interfaces, or a specific group of 
nodes or interfaces. 

Show Query Info This option shows the database queries that have been 
executed to obtain the records. It helps to debug the reports.

Change Max Rows Increases or decreases the number of rows in a table. The 
default is 50. If you expand the default, the table may take 
more time to open. If you are trending a large network, using 
the default ensures that the table opens as quickly as possible. 

View in New Frame Opens the table in a Table Viewer window, as shown in 
Figure 18. If required, make the data in the table more legible 
by resizing the window
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View Options for Graphs

NNMi provides a wide variety of options that enable you to modify the way you view graphs.

Opening a List of Graph View Options

To open a pop-up list of graph view options, do one of the following:

• Report Viewer

Right-click a graph.

• Web Access Server

Select the Edit Graph icon.

The graph view options menu is shown in Figure 17.

Figure 19 Graph View Options Menu 
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Graph View Options

You can change a wide variety of graph view options, as described in Table 1.

Table 2 Graph View Options

Option Function

Set Time Period Alters the relative time period (relative to now) or set an 
absolute time period.

Change Constraint Values Loosens or tightens a constraint, thereby raising or lowering 
the number of elements that conform to the constraint. To 
loosen a constraint, set the value lower. To tighten a 
constraint, set the value higher.

Select Nodes/Interfaces Enables you to change the scope of the table by limiting the 
table to specific nodes, specific interfaces, or a specific group of 
nodes or interfaces. 

Displayed Data For every point on a graph, displays data in a spreadsheet.

Grid Add the following to the graph:
• X axis grid lines
• Y axis grid lines
• X and Y axis grid lines

Legend Deletes or repositions the legend. 

Style See Style Menu Options on page 62.

Show Query Info Shows the database queries that have been executed to obtain 
the records. It helps to debug the reports.

Change Max Rows Increases or decreases the number of rows in a table. The 
default is 50. If you expand the default, the table may take 
more time to open. If you are trending a large network, using 
the default ensures that the table opens as quickly as possible. 

Display Data Table Changes a graph to a spreadsheet, as shown in Figure 27 on 
page 66.

Export Element as CSV... Exports this element into the CSV file.

View in New Frame Opens graph in a Graph Viewer window, as shown in Figure 28 
on page 66.

Print Graph Prints the table or graph that you have chosen.
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Style Menu Options

To display a list of seven view options for graphs, select Style from the main menu, as shown in 
Figure 1.

Figure 20 Style Menu
62 Appendix A



Area Option

The Area option changes the plot or bar chart to an area graph, as shown in Figure 21.

Figure 21 Style Menu: Area Option 

Relative values and total values are easy to view in this format. However, absolute values for 
smaller data types may be hard to see. 

To display the exact value for that location, click anywhere within a band of color.

To shorten the time span of a graph, press SHIFT+ALT and hold down the mouse button to 
highlight the time span on which you want to focus. Release the mouse button to display the 
selected time span.

Stacking Area Option

The Stacking Area option changes the area or plot graph to a stacking area graph, as shown in 
Figure 22. This view is suitable for displaying a small number of variables.

Figure 22 Style Menu: Stacking Area Option
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Bar Option

The Bar option changes the graph to a bar chart. This view is suitable for displaying relatively 
equal values for a small number of variables. There are three variables in the graph shown in 
in Figure 23.

Figure 23 Style Menu: Bar Option

Stacking Bar Option

The Stacking Bar option changes the plot or area graph to a stacking bar chart, as shown in 
Figure 24. If you increase the width of the frame, the time scale becomes hourly. If you increase 
the height of the frame, the call volume shows in units of ten.

Figure 24 Style Menu: Stacking Bar Option

Plot Option

The Plot option changes bands of color in an area graph to lines, as shown in Figure 25. If you 
adjust the frame width, you can make the data points align with hour. If you adjust the frame 
height, you can turn call volume into whole numbers.
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Figure 25 Style Menu: Plot Option

Pie Option

The Pie options changes an area graph to a pie chart, as shown in Figure 26. Bands in an area 
graph convert to slices of a pie and the pie constitutes a 24-hour period. This view is helpful 
when a small number of data values are represented and you are looking at data for one day. 
If you are looking at data for more than one day, you will see multiple pie graphs, one for each 
day.

Figure 26 Style Menu: Pie Option 
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Display Data Table Option

The Display Data Table option changes a graph to a spreadsheet, as shown in Figure 27.

Figure 27 Display Data Table Option 

View in New Frame Option

The View in New Frame option opens a graph in a Graph Viewer window, as shown in 
Figure 28. You can improve legibility by resizing the window.

Figure 28 View in New Frame Option 
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Index
A
adding

alarm categories, 38
LIR mappings, 28
NNMi station, 36
properties, 33

Add or Update Category Information form, 38

Add or Update NNMi List form, 35

alarm categories
adding, 38
removing, 39
updating, 39

Application Server, PI, 21

applying changes to PI forms, 34

architecture, distributed, 11

area graphs, changing
from plot or bar charts, 63
to stacking area graphs, 63

Area option, 63

attributes, defining incidents with NNMi, 12

availability, changing threshold, 41

Availability: SLA Report, 48

Availability Forecast by Customer report, 47

Availability subdirectory, 13

B
bar charts

changing from graphs, 64
stacking, 64

Bar option, 64

bottlenecks, 11

C
canceling changes to PI forms, 34

capacity trends, 11

categories, alarm
adding, 38
removing, 39
synchronizing with nodes, 42
updating, 39

Category subdirectory, 14

CD, extracting packages, 19

central server
configuring, 27 to 31

Change Constraint Values option, 59, 61

Change Max Rows option, 59, 61

changing
area graphs to

pie charts, 65
stacking area graphs, 63
stacking bar charts, 64

availability thresholds, 41
bar charts to area graphs, 63
color bands in area graphs to lines, 64
graphs to

bar charts, 64
spreadsheets, 66

graph views, 16
parameters

Report Viewer, 15
Web Access Server, 16

plot
charts to area graphs, 63
graphs to stacking area graphs, 63
graphs to stacking bar charts, 64

table views, 16
view options, 57
views in PI forms, 34

charts
changing

area graphs to pie charts, 65
bar charts to area graphs, 63
graphs to bar charts, 64
plot charts to area graphs, 63

stacking bar, 64

client documentation, 21

clocks, synchronizing system, 26
  69



closing PI forms, 34

CODA/PA agent support, 11

collecting data
NNMi stations, 33 to 42
PI

description, 11
process, 42

collection details, checking, 42

color bands, changing to lines, 64

command, setup, 19

Common Property Tables
required version, 17
upgrading, 20

configuring
central server, 27 to 31
satellite server, 31

Consolidated subdirectory, 14

consolidating PI and NNMi data, 11 to 12

copy policies
automatically generated, verifying, 29
generating manually, 29
setting copy type manually, 30

copy type, setting manually, 30

creating Web Service Client User Account, 18

customer availability reports, 47

customers, sharing reports with, 15

customizing reports, 15 to 16

D
data

collecting
NNMi stations, 33 to 42
PI, 11, 42

consolidating PI and NNMi, 11 to 12
warehousing, 11

default view
forms, 34
tables, 57

defining incidents with NNMi attributes, 12

deployed reports, viewing, 21

Detailed Availability Report on Node Level, 46

Detailed Availability Report on Station Level, 45

device reports
Hot Spots: Top 20 by Device, 53
NNMi Incidents by Severity and Device, 55

Device view, 34

directories, Report Pack, 13 to 14

display, limiting report, 15

Display Data Table option, 61, 66

Displayed Data option, 61

displaying view options for graphs, 62

distributed
architecture, 11
system, setting up, 25 to 31

distributed system
reporting, 26

documents, related
clients, 21
Report Pack, 16

E
editing process files

central server, 30
satellite server, 31

Edit Parameters window, 16

enabling local independent reporting, 27

Executive Summary by Severity report, 56

Executive Summary by Vendor report, 50

Export Element as CSV option, 61

extracting Report Pack CD, 19

F
features, PI, 11

files
editing process

central server, 30
satellite server, 31

troubleshooting
NNM8i_Datapipe.log, 42
trend.log, 42

Forecast by Severity report, 52

forms
Add or Update Category Information, 38
Add or Update NNMi List, 35
launching PI, 34
navigating PI, 34
Remove Alarm Category, 39
Remove NNMi Station, 37
Update Availability Threshold, 40

functions, view option
graphs, 61
tables, 59

G
General subdirectory, 13
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generating
copy policies manually, 29
reports, 12

graphs
changing

area graphs to stacking bar charts, 64
bar charts to area graphs, 63
color bands to lines, 64
graphs to bar charts, 64
graphs to pie charts, 65
graphs to spreadsheets, 66
plot charts to area graphs, 63
plot graphs to stacking bar charts, 64
views, 16

displaying view options, 62
opening view options, 60

Graph Viewer window, 66

Grid option, 61

H
Hot Spots: Top 20 by Device report, 53

hourly_NNMI_Avail.pro file
central server, 30
satellite server, 31

hourly_NNMI_INCIDENT.pro file
central server, 30
satellite server, 31

HP Network Node Manager i-series Software. See 
NNMi

HP Performance Insight. See PI

HP-UX
restarting OVPI Timer

installing Report Pack, 21
uninstalling Report Pack, 23

stopping OVPI Timer
extracting packages from CD, 19
unistalling Report Pack, 22

I
Incident and Availability Report Pack. See Report 

Pack

incident reports
Executive Summary by Severity, 56
Hot Spots: Top 20 by Device, 53
Incident Summary by NNMi Station, 51
NNMi Incidents by Category and Device, 54
NNMi Incidents by Severity and Device, 55

incidents, defining with NNMi attributes, 12

INCIDENT subdirectory, 13

Incident Summary by NNMi Station report, 51

Installation Progress window, 20

installation requirements, 17

installing Report Pack, 20 to 21

L
launching PI forms, 34

Legend option, 61

limiting report display, 15

LIR
adding mappings, 28
description, 26
enabling, 27

location-independent reporting
adding mappings, 28
description, 26
enabling, 27

log files
NNM8i_Datapipe.log, 42
NNMi stations, 42
trend.log, 42

M
management console window, 34

manually
generating copy policies, 29
setting copy type, 30

Microsoft Windows. See Windows

modifying
process files

central server, 30
satellite server, 31

properties, 33

Modify Parameter Values window, 15

N
navigating PI forms, 34

Near Real Time reports
PI, 11

Network Node Manager i-series Software. See NNMi

NNM8i_Datapipe.log file, 42
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NNMi
checking collection details, 42
collecting data from stations, 33 to 42
creating Web Service Client User Account, 18
defining incidents with attributes, 12
node reports, 46
station reports

availability details, 45
incident summaries, 51

troubleshooting stations, 42
updating stations, 35 to 36

NNMi_Incident_Demo package
installing Report Pack, 20
uninstalling Report Pack, 22

NNMi_Incident package
installing Report Pack, 20
uninstalling Report Pack, 22

NNMI_Report directory, 13

NNMi Incidents by Category and Device report, 54

NNMi Incidents by Severity and Device report, 55

NNMi view, 37

nodes
availability reports, 46
synchronizing with categories, 42
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PI, 11

O
Object/Property Management view

launching
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reports, 21

removing
catagories for NNMi stations, 40
NNMi stations, 37

opening view options
graphs, 60
tables, 58

options
Area, 63
Bar, 64
customizing report, 15 to 16
Display Data Table, 66
Pie, 65
Plot, 64
Stacking Area, 63
Stacking Bar, 64
Style menu, 62
view

changing, 57
graphs, 60 to 61
tables, 58 to 59

View in New Frame, 66

OVPI Timer
restarting

installing Report Pack, 21
uninstalling Report Pack, 23

stopping
extracting packages from CD, 19
uninstalling Report Pack, 22

P
Package Location window

installing Report Pack, 20
uninstalling Report Pack, 22

Package Manager Welcome window
extracting packages from CD, 19
installing Report Pack, 20
uninstalling Report Pack, 22

Package Selection window
installing Report Pack, 20
uninstalling Report Pack, 22

parameters, changing
Report Viewer, 15
Web Access Server, 16

Performance Insight. See PI

PI
Application Server, 21
checking collection details, 42
collecting data, 11, 42
features, 11
navigating forms, 34
processing data, 11
versions, 17

pie charts, changing area graphs to, 65

Pie option, 65

plot
charts, 63
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72



Plot option, 64

policies
generating copy manually, 29
verifying copy, 29

pop-up windows, 34

Print Graph option, 61

process files, editing
central server, 30
satellite server, 31

processing data with PI, 11

Progress window, 22

properties, adding, 33

R
registering satellite server, 27

related documents
clients, 21
Report Pack, 16

Remove Alarm Category form, 39

Remove NNMi Station form, 37

removing
alarm categories, 39
NNMi stations, 37

Report Deployment window, 20

reporting
distributed system, 26
LIR

adding mappings, 28
description, 26
enabling, 27

NRT, 11
setting up, 25, 26

Report Pack
extracting packages from CD, 19
installing, 20 to 21
parameters, 15
uninstalling, 22 to 23

reports
Availability: SLA Report, 48
Availability Forecast by Customer, 47
customizing, 15 to 16
Detailed Availability Report on Node Level, 46
Detailed Availability Report on Station Level, 45
Executive Summary by Severity, 56
Executive Summary by Vendor, 50
Forecast by Severity, 52
generating, 12
Hot Spots: Top 20 by Device, 53
Incident Summary by NNMi Station, 51
limiting display, 15
NNMi Incidents by Category and Device, 54
NNMi Incidents by Severity and Device, 55
Report Pack, 13 to 14
sample, 43 to 56
sharing with customers, 15
viewing deployed, 21

Report Undeployment window, 22

Report Viewer, changing
parameters, 15
view options, 57

requirements, installation, 17

restarting OVPI Timer, 21

root user
extracting packages from CD, 19
installing Report Pack, 21

S
sample reports, 43 to 56

satellite server
configuring, 31
registering, 27

Selection Summary window
installing Report Pack, 20
uninstalling Report Pack, 22

Select Nodes/Interfaces option
graph views, 61
table views, 59

server
central

configuring, 27 to 31
satellite

configuring, 31
registering, 27

Server, PI Application, 21

Set Time Period option
graph views, 61
table views, 59
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setting up
distributed system, 25 to 31
steps for distributed system, 25

setup command, 19

severity reports
Executive Summary by Severity, 56
Executive Summary by Vendor, 50
Forecase by Severity, 52
NNMi Incidents by Severity and Device, 55

Severity subdirectory, 14

sharing reports with customers, 15

SLA availability reports, 48

SOAP calls, 12

software versions, 17

Solaris
restarting OVPI Timer

installing Report Pack, 21
uninstalling Report Pack, 23

stopping OVPI Timer
extracting packages from CD, 19
uninstalling Report Pack, 22

spreadsheets, changing graphs to, 66

stacking
area graphs, 63
bar charts, 64

Stacking Area option, 63

Stacking Bar option, 64

starting OVPI Timer
installing Report Pack, 21
uninstalling Report Pack, 23

stations, NNMi
collecting data, 33 to 42
reports, 45, 51
troubleshooting, 42
updating, 35 to 36

stopping OVPI Timer
extracting packages from CD, 19
uninstalling Report Pack, 22

Style menu options, 62

subdirectories, Report Pack, 13 to 14

Sun Solaris. See Solaris

synchronizing
nodes and categories, 42
system clocks, 26

system
setting up distributed, 25 to 31
synchronizing clocks, 26

T
tables

changing views, 16
display data option, 66
view options, 58 to 59

Table Viewer window, 59

threshold, changing availability, 41

trend.log file, 42

trendadm user, 22

trend lines, incident, 56

trends, capacity, 11

troubleshooting NNMi stations, 42

type, setting copy, 30

Type Discovery window, 20

U
uninstalling Report Pack, 22 to 23

UNIX
logging on as

root, 19
trendadm, 22

restarting OVPI Timer
installing Report Pack, 21
uninstalling Report Pack, 23

stopping OVPI Timer
extracting packages from CD, 19
uninstalling Report Pack, 22

Update Availability Threshold form, 40

updating
alarm categories, 39
availability threholds, 41
NNMi station, 35 to 36

upgrading Common Property Tables, 20

Use Absolute Time option, 59

users
root

extracting packages from CD, 19
installing Report Pack, 21

trendadm, 22

V
vendor, reports, 50

verifying copy policies, 29

versions, software, 17

viewing deployed reports, 21
74



View in New Frame option
graph view, 61
Graph Viewer sindow, 66
table view, 59

view options
changing, 57
graphs

functions, 61
opening, 60

tables
functions, 59
opening, 58

view options, displaying graph, 62

views
changing

PI forms, 34
tables and graphs, 16

default
changing views, 57
launching forms, 34

Device, 34
NNMi, 37
Object/Property Management

categories for NNMi stations, 40
forms, 34
NNMi stations, 37
reports, 21

W
Web Access Server, changing

parameters, 16
view options, 57

Web Service Client User Account, creating, 18

windows
Edit Parameters, 16
Graph Viewer, 66
Installation Progress, 20
management console, 34
Modify Parameter Values, 15
Package Location

installing Report Pack, 20
uninstalling Report Pack, 22

Package Manager Welcome
extracting packages from CD, 19
installing Report Pack, 20
uninstalling Report Pack, 22

Package Selection
installing Report Pack, 20
uninstalling Report Pack, 22

pop-up, 34
Progress, 22
Report Deployment, 20
Report Undeployment, 22
Selection Summary

installing Report Pack, 20
uninstalling Report Pack, 22

Table Viewer, 59
Type Discovery, 20

Windows, restarting OVPI Timer
installing Report Pack, 21
uninstalling Report Pack, 23
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